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Liste des ajouts et corrections 
 

23/04/2016  version 1.60: 

 Ajout du chapitre « Mise au point automatique avec MaxilDL » 

 

10/04/2016  version 1.50: 

 Ajout du chapitre « Mise au point automatique avec FOCUSMAX » 

 Chapitre paramétrage EQMOD enrichie avec l’utilisation d’un Joystick 

 

08/04/2016  version 1.40: 

 Ajout du chapitre « Le tout remote »  

 

07/04/2016 version 1.30: 

 Ajout de capture d’écran 

 

19/09/2015 version 1.20: 

 * Fonction Astrometric Resync du chapitre 11 

 * Ajout du chapitre PASSAGE AU MERIDIEN 

 

06/08/2015   version 1.10: 

 * Ajout du chapitre consacré à l'utilisation de stellarium 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Ce tutoriel présente la plupart des fonctionnalités proposées par les logiciels MaximDL associé à EQMOD pour la phase 

d’acquisition, ainsi que leurs mises en œuvre. La version utilisée de MaximDL est la 5.24, mise à jour finale et stable de la version 

5.  

    Ce logiciel permet notamment : 

- D’imager en APN et en CCD 

- D’autoguider de façon simple 

- De piloter une monture en ASCOM 

- De pointer n’importe quel objet des différents catalogues embarqués (Messier, IC, Sharpless,…) grâce à son planétarium 

- … 

   Mais surtout, MaximDL possède une puissante fonction d’astrométrie permettant de centrer facilement un objet sur son capteur 

CCD  

 

 

Toutes ces solutions ont été testées avec succès par mes soins. Il en existe d’autres 

 

A NOTER : la configuration proposée ici ne nécessite pas l’utilisation d’un câble ST4 puisque les commandes de correction de 

l’autoguidage passent par EQMOD, ce qui est censé produire un guidage plus en douceur. 

 

     Merci de me remonter toute erreur et/ou faute qui s'y serait glissée. 
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1 – MATERIEL UTILISE 

 
  La connexion de la monture au PC peut se faire de différentes façons : 

- Câble série connecté au port série du PC d’un côté, à la raquette de la monture de l’autre 

- Câble USB- série connecté au port USB du PC d’un côté, à la raquette de la monture de l’autre 

- Câble USB- série connecté au port USB du PC d’un côté, à la place de la raquette de la monture de l’autre 

- Module Bluetooth connecté à la place de la raquette pour une communication sans fil 

 

Vous trouverez tous ces câbles chez Pierro-Astro à l’adresse suivante : 

http://www.pierro-astro.com/materiel-astronomique/interface-eqmod 

 

   Afin de réduire les câbles entre la monture et le PC, et le nombre de connexion USB, il peut être utile d’installer un boitier 

Silex 4000 : 

http://www.pierro-astro.com/materiel-astronomique/accessoires-informatiques/silex-sx-ds-4000u2_detail 

   Celui-ci se fixe au niveau de la monture et permet de piloter tous les périphériques USB via un seul câble Ethernet relié au PC. 
 

2 - REGLAGE EQMOD 

 
    On suppose ici que la plateforme ASCOM 6.2 est installée ainsi que le driver ASCOM pour la monture (EQASCOM HEQ5/6 

dans la plupart des cas) 

 http://ascom-standards.org/ 

 

- Cliquer sur EQMOD_toolbox (se trouve dans ProgramFiles(x86)/EQMOD) 

 

 
 

- Cliquer sur Driver Setup 

 

http://www.pierro-astro.com/materiel-astronomique/interface-eqmod
http://www.pierro-astro.com/materiel-astronomique/accessoires-informatiques/silex-sx-ds-4000u2_detail
http://ascom-standards.org/
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- Dans la zone Detail Port EQMOD : 

 * Timeout : 2000 

 * Retenter : 1 

 * Baud : 9600 

 * Port : le port COM d’EQMOD (il apparaît dans le gestionnaire des périphériques) 

- Dans la zone Lieu d'observation, sélectionner le lieu dans le menu déroulant ou entrer de nouveaux lieux et les sauvegarder 

- Pour utiliser un Joystick facilitant le pointage du télescope (idéalement un Joystick sans fil), cliquer sur la clé à molette dans la 

zone Joystick 

 

 
 

  Celui-ci étant supposé connecté, EQMOD propose un paramétrage par défaut que l’on peut modifier en cliquant sur la 

commande et en remplaçant par le boutant choisi. Valider avec le bouton Confirmer changement 

 

- cliquer sur OK 
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3 – PARAMETRAGE DE MAXIMDL 
 

   On suppose ici que MAXIMDL V5.24 a été installé ainsi que le catalogue GSC 1.1 dans le répertoire par défaut. On peut 

télécharger ce catalogue à l’adresse : http://gsc.dc3.com/GSCInstall.exe 

    Il faut également avoir les drivers des caméras CCD d’imagerie et d’autoguidage, ainsi que leurs drivers ASCOM 

correspondants. Pour la plupart des APN, les drivers sont proposés en natif donc rien à installer   

 

A – Paramétrages généraux 

 

- Démarrer MAXIMDL 

 

 
 

- Dans le menu déroulant View->ToolsBars ne garder que Standard de sélectionner. Seuls les icônes suivants sont visibles : 

 * Ouvrir un fichier image 

 * Sauver une image 

* Revenir en arrière (grisé) 

* Rétablir une modification (grisé) 

* Screen Stretch pour régler les niveaux d’une image 

* Information 

* Toggle Camera Control pour le contrôle des cameras 

* Toggle Observatory Control pour le contrôle de la monture, du dôme, du focuseur,… 

* FITS Header pour l’affichage de l’entête sur les fichiers FITS 

* Zoom in et Zoom out pour zoomer / Dézoomer sur l’image. On peut également utiliser la molette de la souris  

- Ouvrir File->Settings et dans l’onglet Site and Optics renseigner les caractéristiques du matériel (Main Telescope et Guide 

Telescope) 

http://gsc.dc3.com/GSCInstall.exe
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- Entrer la position du site dans Site Location ou cliquer sur Load From Scope si la monture est déjà connectée puis valider par 

OK 

 

 
 

- Ouvrir File->Configuration puis entrer un nom de configuration puis cliquer sur Save As. Tous les paramètres actuels de 

MaximDL sont sauvegardés. Si vous modifiez ces paramètres, il faudra à nouveau sauvegarder la configuration dans ce menu.  
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B – Paramétrage de la monture 

 

- Cliquer sur l'icône Toggle Observatory Control (ou CTRL-T)  

 

 
 

- Sélectionner l'onglet Setup et dans la zone Telescope cliquer sur Option->Choose: choisir POTH Hub puis cliquer sur Properties 

 

 
 

- Cliquer sur Choose Scope, sélectionner sa monture puis cliquer sur OK 

- Cliquer à nouveau sur Ok  

- Cliquer sur Connect pour vérifier que la fenêtre EQMOD se lance normalement 
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C – Paramétrage des caméras 

   

- Cliquer sur l'icône Toggle Camera Control (ou CTRL-W).  

 

 
 

Sélectionner l’onglet Seup.  Camera 1 est la zone réservé pour la camera ou l’APN, Camera 2 est la zone pour la caméra 

d’autoguidage 
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1) Cas de l’APN 

- Dans la zone Camera 1 cliquer sur Setup Camera 

- Sélectionner Camera Model, Canon Eos II par exemple pour la plupart des Canon 

- Shutter Release sur USB (sauf EOS350D avec câble déclencheur) 

- Canon DLLs sur EOS Utility (toujours dans le cas de Canon) 

- Le reste par défaut et cliquer sur OK 

 

2) Cas de la CCD 

- Dans la zone Camera 1 cliquer sur Setup Camera 

- Sélectionner Camera Model, ASCOM si celle-ci possède des drivers ASCOM ( cas des caméras ATIK) puis 

Advanced pour choisir le driver. Valider par OK 

- Dans Setup Filter sélectionner le type de roue à filtre utilisée. Pour une roue ASCOM, cliquer sur Advanced 

pour choisir le driver de la roue à filtre. Cliquer sur chacun des champs pour donner un nom (filter name) à 

chaque position de la roue à filtre. Valider par OK 

 

- Dans la zone Camera 2 cliquer sur Setup Camera 

- Sélectionner Camera Model et Advanced selon la camera d’autoguidage utilisée. Valider par Ok 

- Cliquer sur Connect pour vérifier que les caméras se connectent correctement 

- Cliquer sur l'icône Toggle Camera Control (ou CTRL-W). Sélectionner l’onglet Guide puis cliquer sur Settings. Dans la zone 

Autoguider Output, sélectionner Contrôle Via Telescope 

 

 

4- CONNEXION A LA MONTURE 

 
- Démarrer MAXIMDL 

- File->Configuration, sélectionner la configuration puis cliquer sur LOAD 

- Cliquer sur l'icône Toggle Observatory Control (ou CTRL-T)  

- Sélectionner l'onglet Setup et dans la zone Telescope cliquer sur Connect: la fenêtre ASCOM doit s'ouvrir, la monture est 

connectée 

- Cliquer sur l'onglet Telescope 

- Cliquer sur Site 

- Vérifier les zones Main Telescope, Guide Telescope, et dans la zone Site Location cliquer sur Load From Scope: les 

coordonnées du site s'affiche 

- Si la monture était en mode PARK, cliquer sur UNPARK dans la zone Mount 

 

 
 

- Dans la zone Mount, activer Sideral Tracking 

- Cliquer sur OK 

- Fermer la fenêtre Observatory 
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5 - CONNEXION DES CAMERAS 

 
- Cliquer sur l'icône Toggle Camera Control (ou CTRL-W) 

- Cliquer sur Connect: l'état des deux caméras s'affiche dans les deux fenêtres d'information en bas, Camera 1 pour la caméra 

principale, Camera 2 pour la caméra d'autoguidage 

- Dans le cas d’une utilisation avec une CCD ; 

   * Dans la zone Camera 1, cliquer sur Cooler et choisir la température de refroidissement 

 

 
 

*  Cliquer sur OK 

*  Dans la zone Coolers, cliquer sur On: la caméra se refroidit, la température du capteur s'affiche dans la fenêtre 

d'information Caméra 1 

- Fermer la fenêtre Camera Control 
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6 - POINTAGE D'UNE ETOILE 
 

    La liaison avec EQMOD permet de pointer n’importe quel objet automatiquement grâce au planétarium inclut dans MaximDL. 

- Cliquer sur l'icône Toggle Observatory Control (ou CTRL-T) 

- Cliquer sur l'onglet Catalog et choisir une étoile proche de l'objet à imager 

- Choisir dans Category Stars et dans Object ID, entrer le nom de l’étoile puis cliquer sur Search 

 

 
 

- Cliquer sur Go To, la monture se déplace vers la position supposée de l’étoile 

- Quand la monture a fini son déplacement, cliquer sur Sync : la monture est synchronisée avec la position de  l’étoile 

Remarque : pour pointer un objet il est également possible de passer par les onglets All Sky et Zoom, un clic-droit sur l’étoile 

permet de déplacer la monture dessus (Slew to…) ou de la synchroniser (Sync to…)  
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7 - EFFECTUER UNE POSE 

 
- Cliquer sur l'icône Toggle Camera Control (ou CTRL-W) 

- Sélectionner l'onglet Expose 

- Mode Single 

- Exposure Preset : Find Star 

- Cas d’un APN : 

* Seconds : 30s 

* Readout Mode : jpeg monochrome 

* ISO : Auto 

- Cas d’une CCD : 

 * Seconds : 10s avec un filtre L 

 * Filter Wheel : Luminance 

 * Binning : 2 

- Vérifier que le mode Camera 1 est sélectionné 

- Vérifier dans Options que No Calibration est coché 

- Cliquer sur Start pour effectuer une pose, la photo apparaît.  

- Cliquer sur l’icône Toggle Screen Stretch Windows (ou CTRL-H) pour ajuster les niveaux de l’image 

- Clic-droit sur la photo et choisir Crosshairs->visible pour faire apparaître une mire 
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8 – ASTROMETRIE: CENTRAGE DE L’ETOILE 
 

    Il s’agit ici de recentrer parfaitement l’étoile au centre du capteur (soit l’équivalent d’un alignement sur 1 étoile). On suppose 

ici que la mise au point est à peu près réalisée, sinon voir chapitre MISE AU POINT 

 

- Si l’étoile n’est pas dans le champ, utiliser les touches de direction d’EQMOD (ou le Joystick) pour recentrer à peu près l’étoile. 

IMPORTANT : suite à cette manœuvre, il faut resynchroniser la monture. Dans l’onglet Catalog de la fenêtre Observatory, cliquer 

à nouveau sur Sync. Vérifier dans l’onglet Zoom que le curseur se trouve exactement sur l’étoile. Si le Zoom ne fait pas apparaître 

l’étoile, cliquer sur Options->Find Scope Position 

- Cliquer sur le menu Analyse->PinpointAstrometry  

- Dans la zone Image Parameters, activer Fits Scale. Si le message not available s’affiche, l’information de position n’est pas 

disponible dans l’entête du fichier image, procéder alors comme suit : 

 * cliquer sur Set Pixel Scale 

* Sélectionner la zone Calculator et entrer la taille des pixels de la camera ou de l’APN et la longueur focale de 

l’instrument puis cliquer sur Calculate scale : la résolution s’affiche dans la zone Pixel Scale 

  * cliquer sur OK 

 

 
 

- Activer FITS center et vérifier que les coordonnées affichées correspondent bien à ceux indiquées dans l’onglet Catalog de la 

fenêtre Observatory 

- Cliquer sur Process, l’analyse commence, si elle échoue, vérifier les informations indiquées dans Set Pixel Scale ou refaite une 

pose plus longue pour faire apparaître davantage d’étoiles 
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- Une fois l’analyse terminé, le résultat s’affiche dans la fenêtre du bas (avec les coordonnées exactes du centre de la photo) et est 

automatiquement sauvegardé par MaximDL. Cliquer sur Close 

- Dans l’onglet Catalog de la fenêtre Observatory, cliquer sur Sync : choisir le second choix « Solved… », puis cliquer sur Ok 

- Cliquer sur Goto : l’étoile est recentrée, vous pouvez le vérifier en refaisant une pose  

 

 

 

9 – POINTAGE ET CENTRAGE DE L’OBJET A IMAGER 
 

    La procédure est assez proche du pointage sur une étoile 

- Cliquer sur l'icône Toggle Observatory Control (ou CTRL-T) 

- Cliquer sur l'onglet Catalog  

- Choisir dans Category Deep Space et dans Object ID, entrer le nom de l’objet puis cliquer sur Search 

 

 
 

- Cliquer sur Goto, la monture se déplace vers l’objet 

- Effectuer une pose suffisamment longue pour faire apparaître l’objet 

- Si celui-ci n’est pas parfaitement centrée, refaire une analyse astrométrique comme dans le chapitre précédent 
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10 - MISES AU POINT_MANUELLE 

 
- Cliquer sur l'icône Toggle Camera Control (ou CTRL-W) 

- Sélectionner l'onglet Expose 

- Mode Single 

- Exposure Preset : Focus 

- Cas d’un APN : 

* Seconds : 30s 

* Readout Mode : jpeg monochrome 

* ISO : Auto 

- Cas d’une CCD : 

 * Seconds : 10s  

 * Filter Wheel : Luminance 

 * Binning : 2 

- Vérifier que le mode Camera 1 est sélectionné 

- Vérifier dans Options que No Calibration est coché 

- Cliquer sur Start pour effectuer une pose, la photo apparaît 

- Passer en mode Continuous 

- Dans la zone Subframe, activer On et Mouse 

- Repérer sur la photo une étoile isolée suffisamment brillante mais pas saturée 

- En maintenant le bouton gauche de la souris enfoncée, encadrer l’étoile 

- Dans Options activer la fenêtre Display Large Statistic 

- Cliquer sur Start, l’étoile s’affiche dans une cadre réduit, double-cliquer sur l’étoile si les informations FWHM ne sont pas 

rafraichies 

 

 
 

- Ajuster la mise au point pour obtenir la meilleure FWHM 

- Cliquer sur Stop une fois la mise au point obtenue 

- Recommencer la même procédure pour la caméra de guidage en sélectionnant le mode Focus Guider dans  Exposure Preset (le 

mode Caméra 2 doit s’activer, sinon le cocher) 
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11 – MISE AU POINT AUTOMATIQUE AVEC MAXIMDL 

 

MaximDL permet de piloter un focuser et d’effectuer des autofocus. Dans un premier temps, lancer la 

fenêtre Observatory, cliquer sur l’onglet Setup puis sélectionner le focuser utilisé (Choose) 

 

 
 

Cliquer sur Connect pour connecter le focuser. 

Cliquer sur l’onglet Focus 
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Placer le focuser à mi-course à l’aide de la raquette et entrer une valeur de pas (par exemple 50) dans la case 

Incremental et vérifier que le focuser réagit correctement aux boutons Move In et Move Out. Tester 

également un déplacement en valeur absolue en entrant une valeur de position dans Absolute et en cliquant 

sur Move To. 

 

   Cliquer sur le bouton Options : ces paramètres sont importants à renseigner précisément 

 

 
 

 

 Focuser Step Size est la valeur en microns d’un déplacement de 1 pas. Pour le déterminer, 

effectuer par exemple un déplacement de 1000 pas, mesurer le déplacement du porte-oculaire 

correspondant et diviser par 1000. 

 

 Focal Ratio est également important à préciser, c’est la valeur du rapport F/D de votre 

instrument. 

 

 Target ½ Flux Dia. est la valeur en pixel de la taille de l’étoile. Elle doit être le plus bas possible 

mais légèrement supérieur à 2, typiquement entre 5 et 7, et d’autant plus faible que la focale est 

courte. 
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Cliquer sur OK puis sur Exposure (la caméra doit être connectée) : 

 

 
 

 

Ajuster Exposure Time (s) en fonction de la camera et du filtre éventuel utilisé: 1s avec le filtre 

de luminance sur une camera CCD, 2 ou 3 s sur un APN, etc…laisser les autres valeurs par 

défaut pis cliquer sur OK. 

 

  Pointer une étoile dont la magnitude est d’environ 5, elle doit être suffisamment brillante sans 

être saturée. Centrer cette étoile (utiliser clic droit sur la photo, Crossehairs->Visible)  

 

 
 

Cliquer sur Start, MaximDL recherche la meilleure position pour la mise au point. Si le processus 

échoue, augmenter ou diminuer la valeur de Focuser Step Size  

 

 



20 

 

12 - MISE AU POINT AUTOMATIQUE AVEC FOCUSMAX 

 

  MaximDL permet de piloter un focuser et d’effectuer des autofocus. Cependant, Le logiciel FocusMax est 

réputé être plus fiable et plus précis. La dernière version V4 est payante mais vous pouvez télécharger la 

version V3 gratuite (et tout aussi fonctionnelle) à l’adresse suivante : 

  http://www.astronomylog.co.uk/files/focusmax/focusmax-v3.8.0.20.zip 

 

Après avoir téléchargé et installé le logiciel, fermer MaximDL et lancer Focusmax 3   

 

1) Paramétrage de Focusmax 

 

       Tout d’abord, cliquer sur l’onglet System en bas de la fenêtre puis sur le bouton ‘>’ permettant de 

choisir son type de focuser 

 

 

 
 

 

   Sélectionner également Maxim DL dans la zone Camera, le logiciel se lancera automatiquement lors du 

prochain lancement de Focusmax et connectera immédiatement les caméras.  

 

 

 

 

 

 

 

 

 

http://www.astronomylog.co.uk/files/focusmax/focusmax-v3.8.0.20.zip
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   Pour que Focusmax démarre également la connexion à la monture, il suffit de la paramétrer. Cliquer sur 

Telescope 

 

 
 

  Sur la nouvelle fenêtre qui vient de s’ouvrir, cliquer sur l’onglet Setup en bas puis sur le bouton ‘> ‘ pour 

sélectionner votre monture puis valider. 

 

 
 

  Dans l’onglet Site, cocher la case Get from telescope. L’onglet Control vous permet de déplacer la monture 

manuellement. Refermer la fenêtre. 
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  Dans la fenêtre principale, cliquer sur l’onglet Setup et vérifier dans la zone Method que HFD est 

sélectionné. Cliquer sur le bouton Jog pour faire apparaître la boite de commande du focuser. Revenir sur 

l’onglet System et cliquer sur Connect : le focuser et le télescope se connectent, MaximDL se lance et 

connecte également les caméras. Dans MaximDL, il faut cependant quand même connecter le télescope à 

MaximDL en activant le bouton Observatory et activer le suivi sidéral 

 

 
 

  Désormais Focusmax est prêt à être utilisé 
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2) Réalisation des V-Curves 

 

  Focusmax possède un mode automatique qui permet d’appréhender votre matériel sans aucun 

paramétrage préalable. Il faut dans un premier temps réaliser un certain nombre de mesures, appelées 

V-Curve, qui permettront par la suite des mises au point automatiques en moins de 2 mn 

Depuis la fenêtre principale, cliquer sur le menu déroulant Wizard puis First Light 

 

 
 

 Ce processus mesure les caractéristiques du système afin de définir les paramètres optimaux 

de Focusmax. Cliquer sur Next 

 

 

           
 

Dans un premier temps il s’agit de pointer le télescope vers une étoile de magnitude moyenne 

(autour de 5) et proche du zénith pour s’affranchir le plus possible de la turbulence, de la centrer (à 

peu près) sur le capteur et d’utiliser la raquette de commande du focuser (Jog) pour réaliser une 

première mise au point grossière. Cliquer sur Next 
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  Choisir votre configuration (par défaut elle sera sauvegardée sous MySystem, vous pourrez lui 

donner un autre nom à l’issu des mesures). Cliquer sur Next. Focusmax indique de placer les 

différentes fenêtres afin de suivre l’évolution des calculs. Cliquer sur Next puis ajuster la valeur de 

HFD en fonction de la course du focuser : plus celle-ci est courte et plus la valeur du HFD devra être 

petite 

 

             
 

Cliquer sur Next, le processus commence. A l’issu de celui-ci, Focumax affichera une courbe 

de mise au point, placera le focuser sur le point focus calculé et proposera de réaliser une nouvelle 

V-Curve. Pour obtenir suffisamment de précision, réaliser 6 à 10 V-Curves 
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  Après avoir réalisé plusieurs courbes, accéder à la fenêtre des profils (bouton Profile sur la fenêtre 

principale. Consulter la colonne PI Diff et repérer la plus petite valeur : c’est celle-ci qui devra être 

activée. Pour cela, dans la colonne Use, cliquer sur N pour le passer à Y et inversement pour les 

lignes non utilisées 

 

 
 

      Il ne reste plus qu’à sauvegarder la configuration dans le menu déroulant File du menu principal 

 

IMPORTANT : il est inutile de réaliser cette procédure pour les différents filtres de la caméra, le 

profil est valable pour l’ensemble des filtres. Par contre il faudra le faire pour chaque combinaison 

différente de matériel (avec ou sans réducteur, avec Camera ou APN, pour chaque lunette ou 

télescope, etc…) 
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Lui donner un nom correspondant au matériel.  

 

3) Focus 

 

     Lors de la prochaine utilisation avec le même matériel, recharger le profil sauvegardé  
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  Dans l’onglet Setup, ajuster le temps de pose au filtre utilisé 

 

 
 

Réaliser une photo avec MaximDL (inutile de centrer le télescope sur une étoile) puis cliquer sur Focus 

(onglet Focus de la fenêtre principale). La mise au point s’effectue automatiquement et rapidement 

 

 
 

La touche Find laisse Focusmax choisir l’étoile servant à la mise au point. Select permet de la sélectionner 

soi-même. Au cours de la soirée d’acquisition, vous pourrez réajuster la mise au point entre deux photos ou 

au changement de filtres. 
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13 – AUTOGUIDAGE 
 

- Cliquer sur l'icône Toggle Camera Control (ou CTRL-W) 

- Sélectionner l'onglet Guide 

- Régler sur 3 ou 4 secondes 

- Mode Expose 

- Cliquer sur Start 

- Mode Calibrate 

 

 
 

- Double-cliquer sur une étoile 

- Cliquer sur Start, MaximDL effectue sa calibration. Si le déplacement n’est pas suffisant, cliquer sur Settings et augmenter les 

deux valeurs Cal.Time 

- Une fois la calibration effectuée, sélectionner le mode Track, double-cliquer sur une étoile (pas trop brillante) puis cliquer sur 

Start : le guidage commence 

- Cliquer sur Graph. Dans les options de cette fenêtre (petit triangle en bas à gauche), régler Plot sur Line et ajuster Vertical Scale 

en fonction de la qualité du guidage 
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- Ajuster Agressiveness : si la courbe ne revient pas assez vite, augmenter les valeurs, si les corrections sont trop brutales, les 

diminuer 
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14 –LANCER LA SESSION 

 
- Cliquer sur l'icône Toggle Camera Control (ou CTRL-W) 

- Sélectionner l'onglet Expose 

- Mode AUTOSAVE 

- Positionner Exposure Preset à LRVB 

- Vérifier dans Options que No Calibration est coché et dans Set Image Save Path que le répertoire de sauvegarde est correct 

- Cliquer sur AUTOSAVE : 

* Ajuster Delay Between : c’est le temps nécessaire à la stabilisation de l’autoguidage après un dithering (typiquement  

entre 20 et 50s)  

* Dans la zone Dither  sélectionner Via Mount et régler Max Déviation en fonction de la focale  

- Dans le cas d’un APN : 

 * Activer uniquement le premier Slot 

 * Type : Light 

 * Exposure : durée d’exposition  

 * Repeat : nombre de poses 

 * Readout Mode : RAW to hardrive 

- Dans le cas d’une CCD :  

    * Activer autant de Slot qu’il y a de filtres à utiliser 

 * Type : Light 

 * Filter : sélectionner le filtre correspondant au Slot 

 * Exposure : durée d’exposition  

 * Binning : choix du binning 

 * Repeat : nombre de poses 

- La fonction Astrometric Resync permet de refaire une synchronisation astrometric toutes les "i" poses afin de compenser        

l'éventuelle dérive de la monture: 

 * Sync Telescope resynchronise à chaque fois la monture et effectue un Goto sur les coordonnées d'origines 

  * Correct Via Slew effectue juste un Goto sur les coordonnées d'origine sans resynchronisation 

 * Solve Only effectue uniquement l'analyse astrométric sans bouger la monture 

 * Bin 2X2 applique un binning software sur la photo afin de faciliter l'analyse 

 * Interval applique la correction toutes les "i" images 

 

 
- Cliquer sur Apply puis Ok 

- Cliquer sur Start : la session débute 
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15 – MODE PARK ET DECONNEXION 
 

     Une fois la session terminée, il est possible de mettre la monture en mode Park : 

- Cliquer sur l'icône Toggle Observatory Control (ou CTRL-T) 

- Cliquer sur l’onglet Telescope 

- Cliquer sur Park : la monture se remet en position Park. Tous les pointages (clic sur Sync) précédents sont conservés, même      

après arrêt de la monture et du PC 

 

 
 

- Dans l’onglet Setup cliquer sur Disconnect 

- Cliquer sur l'icône Toggle Camera Control (ou CTRL-W) 

- Cliquer sur Disconnect 

- La monture peut être éteinte.  

- Session suivante : après avoir tout reconnecté, cliquer sur l'icône Toggle Observatory Control (ou CTRL-T), sur l’onglet 

Telescope, et cliquer sur UnPark 
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16 – RECENTRER LA MONTURE SUR UN OBJET PRECEDEMMENT IMAGE 
 

      Ce chapitre décrit la procédure à suivre pour récupérer le cadrage d’un objet précédemment imagé, typiquement pour réaliser 

un objet sur plusieurs nuits. Cela suppose de conserver l’orientation exacte de la caméra ou de l’APN sur le porte-oculaire ou pour 

le moins d’être capable de la retrouver assez précisément. Il faut dans un premier temps récupérer les coordonnées de l’image 

d’origine 

- Ouvrir l’image dans MaximDL avec File->Open 

- Dans le menu Observatory, onglet Catalog, effectuer une recherche sur l’objet et relever ses coordonnées.  

- Effectuer une analyse astrométrique sur l’image en rentrant manuellement les coordonnées de l’objet notées précédemment dans 

la fenêtre PinPoint Astrometry. Relevé le résultat de l’astrométrie qui donne les coordonnées du centre de l’image 

- Dans le menu Observatory, onglet Telescope, dans la zone Target Coordinates, entrer les coordonnées du centre de l’image 

relevées à l’étape précédente, puis cliquer sur Goto : la monture se déplace vers la position supposée de l’objet 

 

 
 

- Pour plus de précision, reprendre une acquisition  (chapitre 6)  et refaire une analyse astrométrique sur la nouvelle image 

- Dans le menu Observatory, onglet Telescope, dans la zone Target Coordinates, cliquer sur Image Center from PinPoint puis 

Sync : sélectionner le second choix, la monture est synchronisée sur la position actuelle 

- Reprendre les coordonnées de l’image d’origine puis les rentrer dans Target Coordinates puis cliquer sur Goto: la monture se 

repositionne sur le cadrage exacte de la photo d’origine 
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17 – RECADRER LA MONTURE A PARTIR D’UNE IMAGE  
 

    Ce chapitre décrit la procédure permettant de recentrer la monture sur un point précis d’une image que l’on vient de prendre. 

Exemple : on a demandé un pointage sur M97 qui se retrouve en plein centre de l’image  mais on souhaite avoir M108 également 

sur la photo, le centre de l’image devant se trouver à mi-chemin des deux objets. Un simple clic  permet de réaliser cette 

opération. Il est nécessaire dans un premier temps d’effectuer une calibration de la monture, ces réglages seront conservés tant que 

l’on ne change pas de matériel ou que l’on ne modifie pas l’orientation de la caméra sur la porte-oculaire 

 - Prendre une image et effectuer une analyse astrométrique 

-  Dans le menu Observatory, onglet Telescope, cliquer sur Setup Auto Exposure 

 - Exposure Time à 10s  et Binning 2 (CCD) ou 30s (APN). Cliquer sur Ok 

 

 
 

- Cliquer sur Calibrate, puis sur Use Pinpoint, puis OK. Après un certain temps la monture est calibrée 

 

 
 

- Cliquer-droit  sur la photo à l’endroit qui doit être le nouveau  centre de l’image puis sélectionner Point Telescope Here : la 

monture se déplace de façon à placer le centre de la photo à l’endroit indiqué par la souris 
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18 – PASSAGE AU MERIDIEN 

 

  Même si la fonction d’astrométrie permet de faciliter le passage au méridien, cette opération n’en demeure 

pas moins assez fastidieuse du fait qu’il faille relancer une calibration et un autoguidage après le 

renversement. Pour le cas où la séance d’acquisition débuterait sur un objet proche du méridien, il peut être 

intéressant de forcer la monture à basculer de façon prématurée afin de pouvoir procéder à l’acquisition en 

une seule « passe », donc sans devoir intervenir au milieu de la séance. Cela se fait assez facilement sur 

EQMOD en suivant la procédure suivante : 

- Dans les Options Générales des réglages EQMOD (voir chapitre 1), vérifier que la case Autoriser 

inversion Meridien Auto est décochée. Cliquer sur OK 

 

 
 

- Développer les options de la fenêtre EQMOD (clé à molette) et dans la section Limite Monture 

cliquer sur le paramétrage des limites (clé à molette) 

- Cliquer sur la croix rouge de la section méridien pour désactiver les limites au méridien (Pas de 

limites). Refermer cette fenêtre 
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- Pointer l’objet proche du méridien 

 

- Dans la fenêtre EQMOD, cliquer une fois sur le ‘+’ vert en haut à gauche pour obtenir l’écran    

suivant : 

 
 

- Activer la case « Force Flipped Goto » puis redemander l’objet depuis le planétarium (goto): la 

monture bascule automatiquement. 

 

ATTENTION : ne pas effectuer cette opération pour un objet trop éloigné du méridien au risque de 

voir la lunette ou la caméra taper sur le trépied ou la monture après le basculement 
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19 - UTILISER STELLARIUM AVEC MAXIMDL 

 
    EQMOD offre la possibilité de piloter la monture au travers de plusieurs logiciel fonctionnant simultanément sans que cela  ne 

provoque de conflits. Il est important pour pouvoir utiliser cette possibilité que la driver ASCOM soit positionné sur " POTH Hub 

" et non directement sur EQASCOM HEQ5/6.  Il est alors possible de faire marcher MaximDL avec la plupart des planétarium 

tels que Carte du Ciel, The Sky ou Stellarium. L'exemple porte sur ce dernier, choisi pour sa gratuité et son ergonomie. Cependant 

Stellarium ne peut fonctionner directement en EQMOD mais nécessite l'utilisation d'un utilitaire appelé Stellarium Scope. Il sera 

alors possible de déplacer la monture sur n'importe quel objet du ciel et la synchroniser avec EQMOD, donc l'ensemble des 

logiciels qui y sont connectés. Pour cela suivre la procédure suivante: 

- Télécharger et installer la dernière version de Stellarium à l'adresse suivante: 

http://www.stellarium.org/fr/     

- Télécharger et installer l'utilitaire stellariumscope à l'adresse suivante: 

http://www.welshdragoncomputing.ca/d/dgtocc/st/Setup_StellariumScopeWD_20141109.exe 

 

- Lancer Stellarium 

- Cliquer sur Configuration générale puis sur Plugin 

- Sélectionner Pilotage Automatique et cocher la case Charger au démarrage 

- 

 
 

- Cliquer également sur Oculaires, cocher Charger au démarrage et cliquer sur Configurer 

 
- Dans l'onglet Capteurs, ajouter les différents capteurs CCD et APN utilisés 

http://www.stellarium.org/fr/
http://www.welshdragoncomputing.ca/d/dgtocc/st/Setup_StellariumScopeWD_20141109.exe
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- Dans l'onglet Telescopes, entrer les caractéristiques du matériel utilisé  

- Dans l'onglet Lentilles, ajouter les différents réducteurs et barlow 

- Redémarrer Stellarium pour que les modifications soient prises en compte 

- Arrêter Stellarium 

 

- Lancer StellariumScope 

- Cliquer sur Select mount  

- Choisir POTH Hub 

- Cliquer sur Properties 

- Cliquer sur Choose Scope et choisir I_EQMOD_HEQ5/6 

- Cliquer sur Ok puis à nouveau sur Ok 

- Sélectionner Use J2000 ou Use JNOW selon la  configuration dans MaximDL 

- Cocher Auto start Stellarium next time pour démarrer Stellarium automatiquement lors de la connexion de la monture 

- Cliquer sur Update Stellarium Configuration, Stellarium est configuré 

 

 

 
 

- Cocher Connect, EQMOD se lance (s'il n'était pas déjà ouvert) 

- Démarrer Stellarium soit en utilisant le bouton Start Stellarium, soit manuellement depuis l'icône sur le bureau 

- La position de la monture doit apparaître dans le planétarium sous forme de mire 

- Pour pointer un objet: 

 * Cliquer une fois sur l'objet dans le planétarium ou faire une recherche (F3) 

 * Cliquer sur l'icône Telescope, la fenêtre de pointage s'ouvre 
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 * Cliquer sur Objet actuel pour mettre à jour les coordonnées de l'objet pointé 

 * Choisir l'option Scope 

 

 
  

 * Cliquer sur Objet Actuel 

* Cliquer sur Pointer: la monture se déplace vers l'objet 

 * Pour synchroniser la monture avec une nouvelle position, choisir l'option Sync puis cliquer sur Pointer: le curseur se  

 replace sur l'objet 

- Pour afficher le champ du capteur CCD: 

 * Cliquer sur l'icône du cadrage et faire défiler les différents capteurs, télescopes et lentille pour choisir la bonne 

 configuration: le cadre du champ s'affiche dans le planétarium. On peut également orienter le cadre grâce à l'outil 

 Rotation 
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           Toutes les modifications de pointage et de synchronisation sont bien-sûr répercutées dans MaximDL 
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20 – PILOTER SA MONTURE DEPUIS UNE TABLETTE AVEC SKYSAFARI  

 

    Ce chapitre explique comment piloter sa monture en utilisant une tablette Android ou Ipad, y compris sur 

le terrain (donc sans connexion internet). A noter qu’il existe un module sans fil (SkyFi) qui permet à 

SkySafari de se connecter directement à la monture sans passer par un PC  

             (http://www.skysafariastronomy.com/products/skyfi/index.html) 

 

  Prérequis :  

- Etre connecter à sa monture en Ascom par l’un des différents moyens décrits moyens décrits 

dans le chapitre « Connexion à la monture »  

- Posséder un PC, un smartphone (IOS ou Android), une tablette (IOS ou Android)  

    

a) Il faut tout d’abord créer un réseau Wifi local. Pour cela : 

 

 Sous Android : accéder aux paramètres, puis sélectionner « Réseaux et partage de connexion ». 

Activer alors « Hotspot Wi-Fi ». En laissant le doigt appuyer sur celui-ci, il est possible de 

configurer ce réseau. Certains téléphones proposent également un accès direct depuis l’écran 

d’accueil) 

 Sous IOS : depuis le menu « réglages », sélectionner « Partage de connexion » puis « Hotspot 

personnel ». Activer le hotspot (après avoir rentré un mot de passe)  

 Dans tous les cas ne pas oublier de désactiver la mise en veille automatique du Hotspot si elle 

existe 

 

b) Télécharger WiFiScope sur le PC : 

 

http://www.mainsequencesoftware.com/Products/WiFiScope 

 

   Ce petit logiciel va permettre au PC de recevoir et d’interpréter les commandes envoyées par la tablette 

afin de les renvoyer à la monture. 

 

 
 

Dans Mount sélectionner POTH Hub 

Cliquer sur Settings puis choisir sa monture (HEQ5/EQ6 par exemple) puis OK 

http://www.skysafariastronomy.com/products/skyfi/index.html
http://www.mainsequencesoftware.com/Products/WiFiScope
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Cliquer sur Go : WifiScope est en attente de connexion avec la tablette  

 

c) Sur la tablette, rechercher sur Play Store ou Apple Sore le logiciel (payant) SkySafari 4 Plus ou 

SkySafari 5 Plus et l’installer. Le lancer et toucher Settings. Dans la rubrique Telescope, toucher 

Setup. 

 

 
 

 

Choisir obligatoirement Meade LX Classic pour Scope Type 

Auto-Detect SkyFi à OFF 

Dans IP adress, entrer l’adresse qui apparait sur la fenêtre WifiScope 

Entrer également le port (en général 4030) 

Ressortir du menu, la tablette est prête à se connecter au télescope 

 

d) Connecter la tablette et le PC au réseau Wifi créé à la première étape. Sur la fenêtre principale de 

Skysafari, toucher Scope puis connect : la tablette est désormais connectée à ASCOM via le PC. 

WifiScope indique qu’un nouveau client est connecté. Ajuster la vitesse de déplacement (Slew) 

Vous pouvez depuis SkySafari déplacer la monture N/S/E/W, pointer un objet et le synchroniser  
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21 - LE « TOUT REMOTE » 

 

  Ce chapitre présente une solution complète de contrôle de télescope à distance, typiquement adaptée pour 

une station fixe. A noter que MaximDL propose également une gestion d’un dôme motorisé. La version 6 de 

MaximDL prend en plus en compte le contrôle de stations météos. 

  Pour le contrôle à distance du PC nous utiliserons le logiciel gratuit TeamViewer qui permet de réveiller le 

PC et d’avoir un contrôle complet à distance : 

 http://www.teamviewer.com/fr/ 

TeamViewer est disponible sur tous les supports : Windows, Linux, Mac, smartphone IOS et Android 

 

Cela nécessite un certain nombre de paramétrages : 

 Au niveau du Bios du PC cible 

 Au niveau du routeur 

 Au niveau de la carte réseau du PC cible 

 Au niveau de TeamViewer 

 

1) Paramétrage du Bios 

   

        Démarrer le PC cible (relié à l’observatoire) en maintenant la touche F2 enfoncée afin d’accéder au 

Bios.  Cliquer sur l’onglet Power et passer l’item Wake Up On LAN à Enabled 

 

 
 

 Sauvegarder la configuration et redémarrer le PC 

 

 

 

 

 

 

http://www.teamviewer.com/fr/
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2) Obtenir l’adresse locale de son PC « observatoire » 

 

Depuis une fenêtre de commande (entrer commande dans la recherche Windows (toutes versions), 

taper ipconfig et repérer l’adresse IP de la carte Ethernet du PC (ex. : 192.168.0.54) et la noter 

 

3) Configuration du routeur 

 

Il faut ici configurer le routeur pour permettre de rediriger les commandes vers le PC. 

Accéder aux paramètres du routeur 

Exemple pour Free : 

 Depuis un navigateur entrer l’adresse www.free.fr 

 Se connecter à son compte 

 Dans la rubrique Ma Freebox, sélectionner Configurer mon routeur Freebox 

 En bas de la page, développer Redirections / Baux DHCP et cliquer sur ‘+’ pour ajouter une 

redirection de port. Entrer le port 9 et l’adresse IP notée à l’étape précédente 

 

 
 

 

Sauvegarder les paramètres. Il faudra probablement redémarrer le routeur pour que la modification 

soit prise en compte 

 

 

 

 

http://www.free.fr/
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4) Configuration de la carte réseau 

 

Ouvrir le panneau de configuration Windows puis cliquer sur Réseau et Internet, puis sur Centre 

réseau et partage, puis à gauche sur Modifier les paramètres de la carte. La fenêtre Connexion réseau 

s’ouvre. Repérer l’icône Ethernet puis faire un clic droit dessus puis Propriétés. Cliquer sur 

Configurer puis sur l’onglet Gestion de l’alimentation. Cocher les deux premières cases : 

 

 Autoriser l’ordinateur à éteindre ce périphérique pour économiser l’énergie 

 Autoriser ce périphérique à sortir l’ordinateur de veille 

 

5) Détermination de l’adresse publique 

 

Pour pouvoir accéder à son PC depuis l’extérieur de son réseau local il faut connaître son adresse IP 

publique. Pour cela il suffit de se rendre depuis un navigateur à l’adresse : 

 

http://whatismyipaddress.com/fr/mon-ip 

 

6) Paramétrage de TeamViewer (PC observatoire) 

 

Installer le logiciel TeamViewer sur votre PC et le démarrer. Il faut d’abord créer un compte 

TeamViewer. 

Cliquer sur l’onglet Suppléments puis Option et dans les options générale, cocher tout d’abord 

Démarrer TeamViewer avec Windows puis cliquer sur Affecter un compte. Entrer une adresse Email 

et un mot de passe et valider.   

En face de Wake-on-LAN cliquer sur Configuration, sélectionner le dernier choix Adresse publique 

et entrer l’adresse notée à l’étape précédente ainsi que le port 9 puis cliquer sur OK 

 

 
 

http://whatismyipaddress.com/fr/mon-ip
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  Depuis le menu Options cliquer sur Sécurité à gauche puis entrer un mot de passe et cocher la case 

Accorder un accès facile pour user, ainsi vous ne serez pas obligé de rentrer un mot de passe lors de 

la connexion 

 

 
 

Cliquer sur OK, votre PC est près pour être réveillé et piloté depuis une connexion externe 

 

7) Utiliser TeamViewer 

 

 Votre PC observatoire est supposé éteint. Depuis un PC distant sur lequel est installé 

TeamViewer, démarrer le logiciel et cliquer à droite sur Ouvrir une session et entrer votre adresse 

Email et le mot de passe 

 Dans le menu déroulant Déconnecté, cliquer droit sur votre PC et sélectionner Réveiller 

 Attendre une ou deux minutes le temps de démarrage du PC puis confirmer la connexion : vous 

êtes connecté 

 

 

          L’ensemble de l’installation pourra être surveillé par une ou plusieurs caméras IP.  

La mise sous tension et hors-tension des différents appareils pourra se faire grâce à des boitiers relais 

pilotables par PC ou part Ethernet : 

http://www.domotique-info.fr/domotique/carte-relais-ip/ 

 

 

 

http://www.domotique-info.fr/domotique/carte-relais-ip/

